
  

Submitted by Bobby Jacobs 
 
Giveawayoftheday.com has been giving away soft-
ware for about four years, according to its web-
site.  I receive an email every day which describes 
the program being given away.  I get this email 
because I signed up for it.  You also can go to the 
website everyday and check out the software of 
the day.  The program is free as long as you down-
load and register it the day you get the email.  Per 
their website, “every day we are proud to present 
hot software titles and best software authors from 
all over the world. Also, for game giveaways check 
out http://game.giveawayoftheday.com/ .”  When 
you receive the email, there is a link to the web-
site.  You also can go there directly from the ad-
dress bar.  Then you read about the product and if 
it sounds interesting to you, go to the download 

page.  Then you can see the user ratings.  I always 
look at the comments.  Most times they are very 
useful.  Sometimes they are not.  Asraf’s com-
ments are particularly useful.  He gives the good 
and bad points and usually lists other programs 
that do the same thing.  No program that I have 
tried has caused a problem with my computer.  
After you download the program, open the file up.  
There will be two or three files listed.  Always 
there will be a read me file.  Read it and follow its 
directions.  There will be a setup program.  Use it.  
There might be a register program.  This is the 
tricky part.  To register, most programs do it auto-
matically.  Some you have to put in your email and 
you get a response which you put in the program.  
Make sure you register that day.  Otherwise the 
program will not be free.  
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TOUCHMOUSE 
 
Mouse 2.0  Research Becomes a Reality 
with Microsoft’s New Touch Mouse 
 

During the 2011 International Consumer Electronics 
Show, Microsoft unveiled Touch Mouse, a new multi-
touch device designed exclusively for Windows 7 that 
enables users to click, flick, scroll, and swipe, making 
it easier and more fun to interact with a PC. Touch 
Mouse combines the virtues of a traditional mouse with 
the rich natural language of gesture. 
www.microsoft.com/hardware/touch-mouse 

Members Helping Members 
“Spend Money” 

 

Electroman Surge Protector 
 
The Electroman ($25) turns 
one socket into four, extending 
a helping hands (and another 
hand and two feet to boot). It 
features an on/off switch, and 
also  an indicator light place 
right where Electroman’s heart 
is. Cute! 
 
 
 
 

Better deal do your homework, I found Electroman on 
www.buy.com for $9.99.  
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“Members Helping Members” 
(since 1983) 

Board of Directors 
2010-2011 

 
  Robin Seidenberg . . .. . . . . .. . . . President 
    president@lcace.org     
   
  Linda Busch . . . . . . . . . ... . ..Vice President 
    vicepresident@lcace.org 
 
  Bobby Jacobs. .  . . . . . . .. . . . . . . Secretary 
    secretary@lcace.org 
 
  Winnie Frost . .  . . . . . . . . . . . . . . Treasurer 
    treasurer@lcace.org  
 
  Julio Rivera  . . . . . . . . . . . . .. . . . Programs 
    programs@lcace.org 
 
  Lester Larkin . . . . . . . . . . . . . . Membership 
    membership@lcace.org 
 
  Linda Koudelka . .. .  . . . . . Public Relations 
   pr@lcace.org   
 

Volunteers 
 Webmaster ……………………. Lester Larkin 
   webmaster@lcace.org 
 
 Newsletter Editor …Dwight “J.J.” Johnson 
   editor@lcace.org 

The LCACE News Journal is published eleven 
times annually. Members are encouraged to 
submit contributions which will be acknowledged 
in this newsletter. 
 
Send articles to editor@lcace.org 
Permission is granted to reproduce any or all 
parts of this newsletter in other User Group 
publications, provided that credit is given to 
LCACE and the individual author(s).  
 
The News Journal is produced using a 
L.C.A.C.E  Logo designed on an Atari Stacy 
Laptop in 1989 by Dwight Johnson Jr. 

Lake County Area 
Computer Enthusiasts 

 
LCACE 

c/o Group Ambassador 
 

“J.J.” Johnson 
 

Membership 
Membership in LCACE is open to all individuals 
and families interested in personal computing. 
Annual dues are $20.00 per individual/family. 
Applications for membership may be obtained at 
the monthly meeting, by request on the club 
hotline, and are now available on our web site at  
- http://www.lcace.org. 

 
Meetings 

LCACE meetings are usually held on Saturdays 
at the Grayslake Area Public Library, 100 Library 
Lane, Grayslake, Illinois. The meeting room 
opens at noon and  the formal meeting begins at 
12:30 p.m.  All meetings are open to the public.  
Bring a friend! 

 
Newsletter Submissions 

Club members are welcome to submit classified 
ads, reviews, tips and other articles for 
publication, to our newsletter editor in Microsoft 
Word format (.doc). Publication deadline are 
the 20th of the month all ads, and articles. 
Please refrain from using tabs or special 
formatting.  

 
Newsletter Advertising 

Ad rates per issue: Full page - $25, Half page - 
$15, Quarter page - $10, Business Card - $5. 
Discounts are available on advance purchase of 
multiple issues. Please send camera-ready copy 
and payment to the club address by the 15st of 
the month preceding publication. For more 
information on ad pricing, please call our Hotline. 
Ads are FREE to all paid members. 
 

 Notice 
LCACE WILL NOT CONDONE  or knowingly 
participate in copyright infringement of  any kind. 
The LCACE News Journal is published by and 
for LCACE members. Opinions expressed herein 
are those of the individual authors and do not 
necessarily reflect the opinion of LCACE, the 
membership, the Board of Directors, and/or our 
advertisers. 
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Nancy Becker, who won the 17" HP laptop at our holi-
day party, was a guest at our January 8th meeting along 
with Travis Whitlow, Charles Mages, Wally Olson, and 
Phil Bock.  Julie Bell was the winner of the 4 port USB 
hub door prize; Dorothy Sutherlund won $16 in our 
50/50 drawing.  The meeting featured Show and Tell and 
Ask the Gurus.   J.J. showed us a very informative video 
about Pogoplug, your own personal cloud, which can be 
accessed from anywhere and used by friends, if you grant 
them permission.  Fred Barnett spoke about the Beta ver-
sion of Internet Explorer 9, Android operating systems, 
and windowssecrets.com.  Lester Larkin and Bobby Ja-
cobs talked about giveawayoftheday.com. 
 
Phil Nocerino said that AVG locks up on XP; use Mi-
crosoft Securities Essentials instead.  Robin mentioned 
that Microsoft Security Essentials 2.0 was quietly re-
leased in December (http://www.microsoft.com/
downloads/en/details.aspx?FamilyID=e1605e70-9649-
4a87-8532-33d813687a7f).  It is said to be even better 
than the original version.  Linda Koudelka spoke about 
MalwarebytesAnti-Malware (http://download.cnet.com/
Malwarebytes-Anti-Malware/3000-8022_4-
10804572.html).  Julie Bell mentioned SyperAn-
tiSpyware (http://download.cnet.com/SuperAntiSpyware
-Free-Edition/3000-8022_4-10523889.html). All three 
programs are free. 
 
Lois Berg-Wells told us how to use your cell phone as a 
modem for your laptop.  A brief discussion on cell 
phones yielded the information that any old cell phone 
can be used to access 911.  Save your old cell phones to 
donate to needy senior citizens and battered women so 
they can use them in emergencies.  As long as a cell 
phone is charged, it can be used to call 911 at no charge. 
 
We have exciting programs scheduled for 2011: 
 
February 12, 2011-Ubuntu by Julie Bell 
 

March 12, 2011-Staples of Mundelein on the latest in 
technology 
 
April 2, 2011-Elections, club party, show and tell, ask 
the gurus 
 
May 14, 2011-Digital macro photography by Wendy 
Warden 
 
June 11, 2011-Online banking/internet security/identity 
theft-Detective Tim  Warner, Grayslake Police De-
partment 
 
July 9, 2011-LCACE picnic at Liz and Fred Barnett's 
house 
 
Do you have ideas about programs you would like?  
Please contact Julio Rivera, programs@lcace.org, or 
email me at president@lcace.org. 

LCACE has a three step election process. We take nomi-
nations for board positions in February, March, and 
April. We elect our board at the April meeting, and then 
choose our president from the people elected to serve on 
the board. Please start to think of people you would like 
to nominate. Remember that you can nominate yourself. 
 
 
Happy computing! 

ROBIN’S  

RAMBLINGS 

Put Your Passwords  
On Speed Dial! 
 
Submitted by Bobby Jacobs 
 
Roboform keeps track of all your logins.  Keep all 
your logins completely in sync. No more worries 
about remembering your passwords. Access your 
favorite sites quickly and securely.  You can fill 
forms with a single click.  It can be accessed 
from anywhere you can get to the Internet.  
Check out the platforms for roboform here.  
http://www.roboform.com/platforms/overview 
Now there is a free version of the program.  That 
works, if you only have 10 logins to remember.  
However, if you visit more than 10 sites, you 
might want to consider RoboForm Everywhere.  
The program costs $9.95 for the first year and 
$19.95 for the second year.  There is a 30 trial 
period.  Definitely worth a try. 
http://www.roboform.com/  
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more 

WORDTIPS 
Automatically 

Selecting Words 
When you are editing your document, there are many 
times that Word tries to guess what you are doing and 
then complete your task for you. This helpfulness can 
be aggravating at times. One such instance is when you 
are trying to use the mouse to select text from the mid-
dle of one word to the middle of another. Whenever 
you click inside a word and then start dragging the 
mouse, Word assumes you want to make a selection. 
As soon as you move the mouse pointer outside the 
word, the program assumes you wanted to select the 
entire first word in which you originally clicked. 

If you want to ensure that Word doesn’t make that as-
sumption, you need to follow these steps to turn off the 
offending feature in Word 97 through Word 2003: 

1. Choose Options from the Tools menu. Word 
displays the Options dialog box. 

2. Make sure the Edit tab is selected. 

 
The Edit tab of the Options dialog box. 

3. Make sure the When Selecting, Automatically 
Select Entire Word check box is cleared. 

4. Click on OK. 

You can follow these steps if you are using Word 2007 
or Word 2010: 

1. Display the Word Options dialog box. (In 
Word 2007 click the Office button, then 
choose Word Options. In Word 2010 display 
the File tab of the ribbon, then click Options.) 

2. Click Advanced at the left side of the screen. 

 
The Advanced area of the Word Options dialog box. 

3. In the Editing Options area, make sure the 
When Selecting, Automatically Select Entire 
Word check box is cleared. 

4. Click on OK. 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted 
by permission. Thousands of free Microsoft Word tips can be 
found online at http://word.tips.net. 

 

Atari had talked for years about having a portable Atari 
ST computer system, but it did not arrive until very late 
in 1989 - on Dec 9, 1989 the Stacy finally received 
FCC approval.  
 
Originally designed to operate on 12 standard C cell 
flashlight batteries, this proved insuffient to operate the 
Stacy for an extended period of time. With 4Megs of 
RAM and a hard drive, 15 minutes of use was about all 
the life the batteries could give you. Additionally, the 15 
pound / 7 kg Stacy with external power-pack is some-
what inconvenient to lug around.  
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Jack’s 
Dorothy, Robert, Bobby, Harriet, Lew, Adren, Louis, Robin, 

Fred, Linda, Lester Donna, J.J., Terri 

F 
O 
O 
D 
SIG 

Door Prize Winner 
Julie Bell 

50/50 Winner 
Dorothy (Mom) 

How to get rid of the "This device can perform 
faster" message 
 
When you plug an older USB device into your Win-
dows 7 computer, you might get a pop-up message 
that says "This USB device can perform faster if 

you connect it to a Hi-Speed USB 2.0 port. For a list 
of available ports, click here." You probably just ig-
nore the message or close it with the X, but you can 
prevent it from bugging you every time. Here's how:  
 
1. In the pop-up, click to view the list of available 
USB 2.0 ports. 
2. At the bottom of the dialog box listing the ports, 
you'll see a checkbox (checked by default) that says 
"Tell me if my device can perform faster." Uncheck 
the box. 
Click Close. 

TIPS 

RAFFLE WINNERS 
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News 
Microsoft kills Office anti-piracy program 

Office Genuine Advantage 'served its purpose,' says 
Microsoft as it drops validation checking. 

Read More 

How to Buy a Processor 

There's a lot you need to consider when you're choos-
ing the proper "brain" for your computer, and there are 
a lot of CPU choices on the market. This guide will 
arm you with the basic information you need to make 
an informed choice. 
 
Read More 

 

digitalcorner 
Tips of  the Month 
 

Take monthly photo walks 
Do you take photo’s to relax? Sometimes amid the ten-
sion of photographing for business, or photographing 
for development, it’s easy to forget the enjoyment of 
photography. Return to the joy by scheduling an after-
noon or an hour to walk through a new town, trail, or 
area and find inspiration. Your eyes will be opened in a 
new way, and you will remember the euphoria of crea-
tive discovery. 
 
Backup, backup, backup 
Never work on an original file. Always keep an un-
touched original file somewhere and back up every-
thing. And did I mention—BACKUP! 
 
Formatting 
The best way to avoid having card problems (being 
able to write to a card or read from it) is to get in the 
habit of formatting the card regularly. This is best done 
in the camera, and all digital cameras offer the ability 
to do this. What happens is that a new directory struc-
ture is written to the card, rather than simple writing 
more to the existing one. Just be sure that you’ve al-
ready downloaded any images from the card that you 
want to keep. 
 
Recovery Software 
Threre may be time when you’re unable to get the im-
age off your card. Some of the reasons that can happen 
are because the directory of the card has gotten corupt-
ed., you’ve shot a card full, formatted the card acci-
dently or due to a dying battery. In those cases you’ve 
probably need card recovery software. There are a 
number of programs out there that will recover the im-
ages 90% of the time. SanDisk sells RescuePRO and it 
also comes bundled with their Extreme II and Extreme 
IV cards (as a coupon for download or the software 
itself. Lexar Image Rescue and Photo Rescue are two 
other popular programs. 

COMPUTER QUOTE 
 

“Computers are good at following instructions, but 
not at reading your mind.” 

-Donald Knuth 

Shape Collage 
Automatic Photo Collage Maker 
 

Make picture collage in less  
than a minute with just a few clicks. 
 
Shape Collage ena-
bles you to create 
picture collages from 
your digital images. 
You can choose 
from several differ-
ent shapes and also 
define your own 
shapes by using the 
provided drawing 
tool. You can cus-
tomize the size of 
the collage, define the dimensions of individual images 
and their spacing, add photo borders and more. The 
finished collage image can be saved as JPEG or PNG 
or as Photoshop file in .psd format. The free version 
adds a discrete watermark to the lower right corner of 
the collage. A Pro version with additional features is 
also available. www.shapecollage.com/ 
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COOL TOOL 
 
WinZip® is the original and world's most popular file com-
pression software for Windows. 40% off for Win7news 
readers!! WOOT!!  
http://www.win7news.net/023GAX/101028-WinZip 
 
Why back up when you can sync? Simply replicate every 
piece of data to another drive in real-time. Set it and for-
get it.  
http://www.win7news.net/023GAX/101028-GoodSync 
 
Search for a driver and you get a ton of Driver Software 
offers instead. But how do you know which one is good? 
Try Driver Genious 9.0. Free scan.  
http://www.win7news.net/023GAX/101028-Driver-Genius 
 
Do you have programs you just can't seem to get rid of? 
Uninstaller! 2010 "ALL New" Version Just Released:  
http://www.win7news.net/023GAX/101028-Uninstaller-
2010 

 
Moving to Windows 7 is Easy! PCMover moves pro-
grams, files, and settings from your old PC to your new 
PC.  
http://www.win7news.net/023GAX/101028-PCMover 
 
Billing address autofill, Secure password storage, all au-
tomatic and safe. Not a little toobar utility. Huge time sav-
er!  
http://www.win7news.net/023GAX/101028-Roboform 
 
Get your speed back! Advanced Vista Optimizer will 
tweak Vista for Max performance. Easy to use:  
http://www.win7news.net/023GAX/101028-Vista-
Optimizer 
 
Spellchecker is NOT ENOUGH! Improve your English 
writing skills with WhiteSmoke a smarter solution for high 
quality writing. Try it:  
http://www.win7news.net/023GAX/101028-WhiteSmoke 
 
Ultra Edit New Version 15.2 - Replacing Notepad or 
Looking for The Most Powerful Text Editor?  

WORDTIPS 
AutoFill with  

Random  

Numbers 
Excel includes a feature that allows you to automatically 
fill a range of cells with information you have placed in 
just a few cells. For instance, you could enter the value 1 
in a cell, and then 2 in the cell just beneath it. If you then 
select the two cells and drag the small black handle at the 
bottom right corner of the selection, you can fill any 
number of cells with incrementing numbers. This Au-
toFill feature sure beats having to type in all the values! 

You may wonder if there is a similar way to use the Au-
toFill feature to place random numbers in a range. Unfor-
tunately, the AutoFill feature was never meant for ran-
dom numbers. Why? Because AutoFill uses predictive 
calculations to determine what to enter into a range of 
cells. For example, if you entered 1 into one cell and 5 
into the next, highlighted the cells and then used Au-
toFill, the next number entered in the cell below would 
be 9 because Excel can deduce that the increment is 4. It 
is a constant increment that can be predicted. 

Random numbers on the other hand are, well, random. 
By nature they cannot be predicted, else they wouldn't be 

random. Therefore the predictive nature of AutoFill can-
not be applied to random numbers. 

However, there are ways around this. One is to simply 
use the various formulas (using RAND and RANDBE-
TWEEN) to generate random numbers. These formulas 
can quickly and easily be copied over a range of cells, 
using a variety of copying techniques. 

Another approach is to use a feature of the Analysis 
ToolPak which makes putting random numbers into a 
range of cells pretty easy. Just follow these steps: 

1. Choose Data Analysis from the Tools menu. If 
you are using Word 2007 or Word 2010, you 
display the Data tab of the ribbon and then 
click Data Analysis in the Analysis group. (If 
you don’t see the Data Analysis option on the 
Tools menu or, in Word 2007 or Word 2010, 
you don’t see the Analysis group on the Data 
tab of the ribbon, it means that you don’t have 
the Analysis ToolPak enabled.) Excel displays 
the Data Analysis dialog box. 

 
The Data Analysis dialog box. 
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Tip of the Month 
 

Email Safety 
 
Avoid clicking links in unsolicited emails. Malware-
laden email attachments and malicious links within 
emails are frequent bedfellows in spam. Often, 
bad links are even more insidious than attach-
ments because they can take you to legitimate-
looking Web sites where you my be tricked into 
entering your credit card number or a username 
and password.  

February Door Prize Question 
The first member to bring the answer to the February meeting will win a door prize. 
 

What was the first portable computer? 

 

2. In the list of functions in the dialog box, 
choose Random Number Generation. 

3. Click on OK. Excel displays the Random 
Number Generation dialog box. 

 
The Random Number Generation dialog box. 

4. Using the controls in the dialog box, indicate 
the parameters you want used in generating a 
range of random numbers. (Make sure that 
you specify a range of cells in the Output Op-
tions area of the dialog box.) 

5. Click on OK. 

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted 
by permission. Thousands of free Microsoft Excel tips can be 
found online at http://excel.tips.net. 

(Continued from page 7) 

Patricia Ortseifen 

Mike McEnery 

Tracy Berry 

Bill Hamilton 

Dorothy Sutherland 
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Take a good 
look, you just 

might see  
yourself. 

http://lcace.org/PhotoAlbums.htm 

Have your Web Site Advertised here, 
e-mail me at editor@lcace.org 

 
www.pegasusphotos.zenfolio.com 

 
www.RobinSeidenberg.com  

 Members 

L.C.A.C.E.  
Phone: 847.623.3815 
Web Site: http://www.lcace.org 

 
 

Alleman, Elizabeth esa2204@aol.com 

Anderson, Jean jande77893@aol.com 

Barnett, Fred BNSCom@aol.com 

Becht, George pechmem-gen@yahoo.com 

Bell, Julie jmwebstuff@yahoo.com 

Berg-Wells, Lois luludefl@yahoo.com 

Berndtson, Barton bartb64@yahoo.com 

Berry, Bob & Tracy mgd2race@yahoo.com 

Bitterman, Jay bittjayl@aol.com 

Busch, Linda lindashrub@att.net 

D’Agostino, Robert rusirius2736@sbcglobal.net 

Ditman, Bill william.ditman@comcast.net 

Eisenmann, Richard eisenrich@sbcglobal.net 

Florian, Sherry florina3@earthlink.net 

Frost, Jack Jfrost13@sbcglobal.net 

Frost, Winnie wfrost13@sbcglobal.net 

Garling, Richard richgarling@yellobirdmktg.com 

Gothann, Edward eddiegothann@yahoo.com 

Halley, Jack jack96@aol.com 

Hamilton, Bill hamiltonbill24@comcast.net 

Hanlon, Terri terhanlon@comcast.net 

Henriksen, Henry hhenriksen@wi.rr.com 

Hesse, Gary pocanada@sbcglobal.net 

Hobson, Marshia omsgadget@yahoo.com 

Jacobs, Bobby bobj2361@gmail.com 

Johnson, Dwight jj1450xl@yahoo.com 

Kalinoski, Donna donnaleek@juno.com 

Kline, Cherie catmom1001@aol.com 

Kostelnik, Steve steve_kostelnik@usa.net 

Koudelka, Linda & Robert koudelka3@comcast.net 

Kusiak, Joseph juj014@att.net 

Lagoni, Doreen bearmagic1999@aol.com 

Larkin, Lester LesLarkin@aim.com 

Lewis, Carolyn lewis.linwood@att.net 

Martin, Donald dmartin339@comcast.net 

Mata-Guzman, Marta marta5131959@yahoo.com 

McEnery, John bigjohn1@optonline.net 

McEnery, Mike mmcenery@sbcglobal.net 

Nickels, Cheryl cnickels1110@yahoo.com 

Nocerino, Phil windpiper2@yahoo.com 

Ortseifen, Patricia patricia@ortseifen.com 

Rehberger, Eric graduates63@gmail.com 

Rivera, Julio jlrivera@db3mail.com 

Salsburg, Leslie leslie164@juno.com 

Savage, Danjean & Ken kennethisavage@hotmail.com 

Seidenberg, Lew drlew1@aol.com 

Seidenberg, Robin anguslechat@aol.com 

Smatlak, Ellen emsmis@hotmail.com 

Straw, Gerald gkstraw@comcast.net 

Sturek, Jorja jksturek@sbcglobal.net 

Sutherland, Dorothy deedee1938@yahoo.com 

Urh, John johnurh@sbcglobal.net 

Wagner, Richard & Belinda SenoritaBW@AOL.com 

Wells, Alden alden_racing74@yahoo.com 

Rudnit, Harriet hrudnit@yahoo.com 
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Feburary	

12	

Saturday 

Member  

Profile 
Michael McEnery 
 
Mike is one of our original 
members from the Atari 
Computer days, joining the 
club in 1986. His hometown 
is Merrick Island, New York 
but he now resides in Zion 
with his wife Corrine, son 
Chris and daughter Ginny 
who live close by. Mike retired from the U.S. Navy in 
1993 after twenty-two years of service, and presently 
works as a classroom instructor/facilitator on the Great 
Lakes Naval Base. 
 
Mike has volunteered or been elected to many positions 
since joining L.C.A.C.E.  In the Atari days, he was the 
Public Domain Software Librarian and had to lug all 
those cassettes and then 5-inch floppies to the meetings 
for the members to purchase. Most recently, he has 
served as Desktop Publishing and Beginners/Novice 
SIG Leader, Program, Chairman, Vice President and 
Newsletter Editor. 
 
Mike enjoys attending musical theater with his friends 
from Party of... ; fishing which he talks more about than 
doing, and digital photography which lead him into 
joining Lake County Camera Club. Mike also has the 
natural ability to mess up (CRASH) his computer on 
numerous occasions. 
 
Mike's computer time is spent playing with his Flight 
Simulator (that is after he has rebuilt it form his most 
recent crash). He also enjoys editing digital photos, and 
of course homework.  He states that his favorite pro-
gram is Photoshop that is if he ever learns how to use it. 
His favorite book is Fail Safe and his favorite expres-
sion is the clubs motto "Members Helping Members, 
Spend Money." 
 
His favorite food is Italian (or just anything with pasta), 
and yet his prize possession is his good health. The peo-
ple he admires the most is his father and someone 
named J.J. For years, his friends have been trying teach 
him how to say "NO", and to stop saying “I'm Sorry", 
but in general he is one of the nicest guys you would 
want to know and the "Bestest" friends that anyone 
would ever want have. 

Next  
Meeting 

Meeting Agenda: www.lcace.org 
 

Meeting 
Agenda 

 

Linux 

with 

Julie Bell 


